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Disclaimer 

No part of this book can be transmitted or reproduced in any form including 

print, electronic, photocopying, scanning, mechanical or recording without 

prior written permission from the author. 

All information, ideas and guidelines presented here are for educational 

purposes only. This book cannot be used to replace information provided with 

the device. All readers are encouraged to seek professional advice when 

needed. 

While the author has taken utmost efforts to ensure the accuracy of the 

written content, all readers are advised to follow information mentioned 

herein at their own risk. The author cannot be held responsible for any 

personal or commercial damage caused by misinterpretation of information or 

improper use of the information. 
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Introduction 

Audio books gained popularity with the increase in the pace of technological 

advancements. The changing trend has enabled listeners to think beyond the 

stereos in their cars and homes to access and use audio books. Today, it is 

possible to download audio books onto iPods, MP3 Players, cell phones, 

tablets, iPhones and other PDA (Personal Digital Assistant) devices.  

Audio books provide a convenient way for enthusiastic readers to carry on with 

their daily chores and multitask, such as exercising while listening to 

educational or recreational books. 

Traditionally, audio books were designed for visually impaired individuals. 

However, today they are more of a learning tool and means of entertainment 

for children, teens and adults. There is something for everybody. The most 

popular categories include arts and entertainment, memoirs and bios, classics, 

business, thrillers and mysteries, comedy, fiction, drama, poetry, kids, health 

and fitness, etc.  

The growing market of audio books has encouraged many authors to create 

audio versions of their text or eBooks. While it needs both time and effort to 

produce an audio book, the experience of transforming your book into another 

medium is extremely fun and entertaining.  

You can tap into a great resource for authors wanting to have their books 

recorded by professional voice artists, by using a company that will charge you 

no fees to record your book for you up front, then split the profits of the sales 

50/50. Alternatively you can pay upfront and keep all the profits yourself.  

Also, you can record your own book, thereby avoiding any recording artist 

being required.  We cover this option later in this book. 
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Current popular destinations for your audio book include Amazon, Audible and 

iTunes.  We cover all these publishing marketplaces later in this book too. 

If you are ready to learn some easy and quick tips on creating an audio book, 

you are in the right place. This book is a detailed guide on how you can create 

your own audio book without any hassle or spending money.  

So read on to get to your options!   
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Benefits of Creating Audio Books 

Originally introduced for the purpose of teaching visually-impaired or disabled 

students, non-readers and struggling readers, audio books hold a number of 

great benefits for all types of readers and non-readers. The following are the 

top benefits that encourage authors to create audio books. Have a look: 

A Lucrative Industry  

The audio book industry is worth around a billion dollars. It was estimated 

during December 2004, by the Audio Publishers Association, that the market 

size of the audio book industry was nearly 800 million dollars. Soon after, there 

was exponential growth in the sales of audio books due to the availability of 

downloadable audio books from famous websites such as ChristianAudio.com, 

iTunes and Audible.com. In fact, it is predicted that with the next release of 

APA, it will break the records with over $1 billion in revenue.  

Create your audio book to earn a bit of this action.  

Book Mavens Prefer Listening To Audio Books 

An information connoisseur is known as a maven. People surrounded by 

unsolvable questions often consult the maven present in their lives. For 

instance, for gaining information related to buying a new car, the first person 

you will take advice from will be a car maven. In short, mavens can also be 

called gurus.  

As far as a book maven is concerned, he or she reads more than fifty books per 

year, has information about thousands of books on their fingertips and have 

already piled up books to read on their bookshelf.  
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Book mavens prefer audio books because it gives them a chance to go through 

many more books than they are able to read. They can listen to books while 

working out, driving and even while cooking. If you own audio books, you can 

make good money selling those audio versions by sharing book mavens’ 

recommendations that prefer listening to audio books. 

Save Yourself from the ‘Effects of Oprah’ 

The ‘Effect of Oprah’ appears when a popular person recommends your book 

and you suddenly experience a flock of people simply dying to hold a copy of 

your book. But the current stock of five-thousand books available is cleared off 

the shelves within a few hours and you have to order more prints to entertain 

the demand for your book.  

However, by the time your book is back on the stores’ shelves, people have 

forgotten about it. This results in loss of opportunity as you didn’t have enough 

stock to meet the people’s demand the first time. Both eBooks and audio 

books protect you from this effect and save you from incurring opportunity 

loss. 

If your book is recommended by a famous name, you will never ever face 

shortage of your downloadable audio books. You are safe and covered.  

Boost eBook and Paper Book Sales 

If you have successfully launched an audio book that is well-liked by people, 

they may like to own a paper copy and/or eBook to highlight their favorite 

parts or to flaunt their collection on their bookshelves. So, in addition to audio 

book mavens recommending the book to their acquaintances, you can also 
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experience people buying other mediums of your book after listening to the 

audio book. 

Thus, it is believed that audio books are an efficient way to boost eBook and 

paper book sales. This point is explained in detail later in the book.  

Non-Readers Get a Chance to Go Through Your Book 

For an author, nothing could be more important than knowing that even non-

readers are reading (or listening to, in this case) your books. Apart from the 

huge number of reading enthusiasts, there are many people in the world who 

completely dislike reading and some who do not get a chance from their busy 

schedules to open a book. However, the same people might love listening to a 

book.  

The reasons why non-readers avoid reading could be lack of time or simply 

because they face trouble in reading. Non-readers also include people who are 

blind or struggling with dyslexia.  

With the introduction of audio books, there are increased chances of your 

potential readers’ pie to get bigger. This is exactly what you, as an author, and 

your publishing company, expect and hope for. 

Increased Public Exposure  

By introducing an audio book, it will be easier for people to find you. Audible 

features more than 100,000 books. And as far as Amazon is concerned, there 

are millions of books to be found on their website. By releasing an audio 

version of your book, you can become visible to a crowd of millions and stand 

out in the eyes of readers and listeners.  
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There are readers who search for particular books just to be able to get an 

audio book version of the same. Without audio books, you may disappoint, 

and lose a lot of potential customers. There are still topics that are not covered 

by audio books. You can be the first author to launch an audio book for that 

topic and make the most out of this opportunity.  

The world of audio books is full of book mavens who can make you and your 

books (all versions) famous in no time.  

Experience Practicality  

Using audio books, you can experience more practicality as compared to paper 

books. You can still go through the content of the books regardless of the 

situation or the time, and even when it’s dark. Not only this, with audio books, 

you can save a lot of time which makes the experience convenient for you.  

There is no doubt about the fact that audio books add a component of 

usefulness and simplicity to our busy schedules. So, it doesn’t come up as a 

huge surprise that an increasing number of people are becoming fond of audio 

books.  

History 
Most of us believe that audio books have been around forever. But have you 

ever given it serious thought, and considered who introduced them, how they 

did it and why? Just like books and eBooks, audio books were invented. 

These books were first introduced in the United Kingdom when the Royal 

National Institute for the Blind (RNIB), tried and tested several ways to 

produce a medium of reading for the blind and partially-sighted people.  
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During the year 1934, in the United States of America, a program called ‘Books 

for the Adult Blind Project’ was introduced as the first audio book which 

included ‘The Bible’.  

It was in November 1935 that the first audio book was delivered by the RNIB to 

those that were visually impaired. These initial recordings were Joseph 

Conrad’s ‘Typhoon’ and ‘The Murder of Roger Ackroyd’ by Agatha Christie. 

These initial recordings of audio books were recorded on LP. However, only 25 

minutes of recording was available on each side of an LP record. For this 

reason, more than 10 discs were used to cover a single book. 

Audio Books Today and Tomorrow 

With technological advancements and the advent of the internet, the present 

and future of audio books seems really bright. With the help of the internet, 

people have adopted different ways not only to listen to music, but also to 

these talking books. Since they are widely available on the internet, people can 

download them easily, resulting in a growing demand for audio books. Today, 

it’s possible to download and listen to your favorite audio book collection 

without any hassle. With further advent of technologically advanced gadgets, 

people can hold a great number of audio books at the same time and listen to 

them whenever they like. 

Fortunately, no more bulky and heavy gramophones or tape machines 

required! 
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How Audio Books Support & Promote eBooks 

As mentioned earlier, audio books can boost the sales of your eBooks or paper 

books. In fact, audio books are known for promoting and supporting books 

available on other mediums. Talking books are providing more exposure to 

other mediums as more and more people are becoming increasingly interested 

in audio versions of books.  

Since the different mediums are inter-connected, people searching for audio 

versions may show interest in paper book or eBook versions to keep a written 

with them, perhaps as part of a collection. Similarly, eBooks available on the 

internet, together with their audio versions, are highly preferred by the 

audience.  

Moreover, eBooks can be offered to audiences as a bonus on the purchase of 

audio books or vice versa. This enables readers to identify different mediums 

of the books you have to offer them. Word-of-mouth is indeed a very powerful 

and effective way to promote your books regardless of their versions. When 

free or bonus copies are available for grabs, it is mouth-watering enough for 

readers. 

Introduce your audio book today and boost the sales of your eBook instantly! 

Getting Started with Your Audio Book 

 

Audio books are becoming an adoptive trend for readers and publishers alike. 

This form of books can be easily downloaded on technologically advanced 

gadgets such as MP3 players, CDs, iPods, smart phones, tablets etc. 
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With audio eBooks, you can completely eliminate the need for dedicating time 

to reading out of your busy schedule. In this chapter, you will go through 

friendly guidance for creating an audio eBook and you will be recording your 

very own first copy in no time! Read on.  

You need to first decide if you intend to record your audio book yourself, or if 

you are intending to hire a professional to do it for you. 

If you want to hire someone to record your audio book for you, you have a few 

options.  If you live in the US and publish your audio books with ACX.com, they 

have an offer whereby you can hire their recording artists to record your audio 

book, for an up front fee, OR you can pay them from the royalties of the sales 

of your audio book – a 50/50 split commission, for life.  This way, if you don’t 

want to pay hundred’s up front, you can still get your book recorded and up for 

sale online.   

You could also hire a professional voice artist on Fiverr.com or eLance.com, 

you would have to seek their services with caution as to their terms and end 

cost. 

Alternatively, if you are intending to record your own audio book, then the 

next few chapters will help you achieve that. 

Recording Tips to consider before you Get Started  

- Record in a quiet (as small as possible) room (closets sound more like a 

radio because they are so small and full of clothing, which absorbs echo 

– if you are finding an echo, you need to hang sheets or foam around the 

room to get a better ambience) 
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- Makes sure your seat doesn’t squeak (or your keyboard if you tap the 

keys to move to the next page of the online document) 

- Make sure your voice is appropriate to read out whatever it is you are 

about to read out (practice makes perfect!) 

- Read at the same pace, and read all of the words, you can edit later (if 

you make an error, simply re-record the paragraph/line because you can 

edit that out later in the editing process) 

- Read from your computer or a teleprompter (you can use CuePrompter 

for free online) 

- Each book chapter should be a separate audio file (this is important for 

later when publishing) 

- When you start out, pick your easiest book to record (ideally not too 

long) 

Essential Equipment for Creating Basic Audio Books 

Things You Need: 

 Quality Microphone 

 Preamp (optional) 

 Microphone Stand 

 Computer  

 Audio Speakers 

Instructions: 

1. Before you set out to purchase what you need, conduct proper research 

for a suitable condenser microphone that falls within your budget, holds 

a successful history and base your judgment on features and reviews 

http://www.cueprompter.com/
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available. A vibrating chamber is used by a condenser microphone for 

recording, ideal for responding to delicate voices such as the human 

voice. On the other hand, dynamic microphones are not considered the 

most ideal choice, since they are more rugged.  

2. Choose a suitable mic-stand and adjust your microphone. Your choice 

for a mic-stand completely depends on your recording style. You may 

choose to have the musical mic-stand or a desk-seated, smaller stand.  

High quality HD Webcams (eg. Logitech c920 retails for around $99) have 

also been considered adequate to record with if the room is ambient 

enough.   

Another well-regarded microphone on the market at the moment, 

perfect for podcasting and recording your audio book is the Audio 

Technica ATR2100 (which retails for around $60) and can be plugged 

into your computer with the standard USB  but also comes with the jack 

to connect to a mixer if you decide to go more high tech later on with 

your recording equipment. 

3. If you get a preamp, get one capable of boosting and powering signals 

from your microphone. Look for a preamp that offers a full complement 

of features that enable sound-enhancing qualities, such as a 20 decibel 

pad, limiter and gain without leading you to unnecessary whistles and 

bells. Plug in the cord of your microphone into the input channel of your 

preamp.  

4. Next, access a computer to record your audio files, one capable of 

transforming them into an mp3 format. A simple computer will be able 

to perform this task efficiently. Since you do not require high-end 

equalization features or sound effects, Audacity, a free tool for 

recording, is adequate to fulfill your needs.  
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5. You should then listen to what you have recorded using studio speakers. 

To do so, you must ensure that the speakers are placed in a sound-proof 

environment. Listen to your recorded audio files and identify if there is 

any noise pollution. Re-record in a noise-free environment if needed.  

Alternatively you could just use headphones. 

6. Finally, you will need cover art for your audio book, and here are some 

solutions for you: 

a. Create it yourself in a simple free online software like “iPiccy.com” 

which has numerous tutorials on how to create eCovers with 

iPiccy on YouTube. 

b. Hire someone on Fiverr.com 

c. Hire someone on a freelance site like eLance.com, Odesk.com, 

Shelancers.com etc 

Regardless of what you choose, ensure that your final cover art comes in 

two sizes (always JPG): 

o 1448 x 1448px 

o 800h x 600w 

Popular Topics – Guarantee Success by Choosing 

the Right Subject for Your Audio Book 

It is very important to classify audio books into relevant categories to help 

readers find the desired book from the hundreds of thousands of books 

available online. Readers can view audio books in different genres and 

categories. Best-selling books are easier to find because they lie on top of the 

list in each category.  

http://ipiccy.com/
https://www.youtube.com/results?search_query=ipiccy+tutorial&oq=ipiccy+tutorial&gs_l=youtube.3..0.221.2840.0.3054.14.9.0.4.4.1.275.1560.2j2j5.9.0...0.0...1ac.1.P9wJFV5c8f8
http://fiverr.com/
https://www.elance.com/
https://www.odesk.com/
http://www.shelancers.com/
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So, now that you know the importance of classifying your audio book, it is also 

important that you learn about the popular topics that can give your audio 

book more exposure and public interest in no time. The following are three 

successful categories you can gain from, provided you have chosen the right 

subject, theme and language for your audio book. 

DIY How-to Guides 

‘DIY how-to guides’ are successfully becoming the most in-demand audio 

books available today. These books can help you with different DIY projects as 

you listen to them and perform the directions accordingly.  

Imagine someone telling you how to do something step-by-step and you are 

following the guidelines to the letter? Reading about, and performing, a DIY 

project is a much more difficult task as compared to listening to one and doing 

it simultaneously. Thus, these types of books are becoming increasingly 

popular amongst readers and publishers.  

Under this heading, you can create any type of ‘how-to’ guides that you 

believe will be highly entertained by readers. You can opt for an audio recipe 

book, or simple transformation of old furniture or an audio guide on interior 

designing – the choice is completely yours.  

You can pair these audio books with free eBook samples of pictures that show 

the end result of the guide available in the audio version. For instance, if you 

are planning a recipe book, offer a bonus eBook with pictures of the food you 

have covered in the audio guide. This is a simple trick that will help you make 

your audio book stand out from the rest.  
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Fiction Stories 
A majority of readers are rather fond of fiction stories and have bookshelves 

bursting with entire collections from their favorite authors. Reading fiction 

enables readers to experience a completely new world and live a completely 

different life. However, readers are no longer bound to seeing a different 

world by just reading about it.  

Reading and imagining yourself to be an entirely different person in a fantasy 

world could be difficult as compared to listening to a story, closing your eyes 

while imagining yourself so and experiencing it to the core. This experience can 

be gained with audio books.  

Now that paper books and eBooks have gained adequate popularity, it’s time 

to introduce fiction in a new medium, one highly preferred by readers as well 

as by non-readers these days. Publish your audio book and experience high 

demand for your book once again. Provide a chance to your audience to listen 

to their favorite book and experience their favorite character a little differently 

this time.  

Children’s Learning Books for Educational Benefits 

When it comes to children, audio books are indeed a valuable media source for 

them to learn. Children’s books are in high demand in an audio format because 

the correlation between reading and listening to audio books is extremely 

positive and more and more librarians and teachers are using audio books for 

teaching children. The following are some educational benefits of introducing 

children’s learning books in an audio format.  

 Improves speaking skill. 
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 Enhances vocabulary. 

 Keeps up the storytelling trend – a significant historic tradition. 

 Engages children of all ages as they sit, listen, and fantasize at the same 

time. 

 Introduction of difficult names, pronunciation and new vocabulary. 

 Story books in audio format can help children relax when they are too 

tired to study or read. 

 A comfortable and efficient way of teaching kids for parents and 

teachers. 

All in all, a majority of children find listening to lessons and stories on audio 

books fun and entertaining. Not a lot of children are fond of reading which is 

why most of them spend more time watching movies than reading books.  

The audio book technology is widely embraced by schools today in order to 

adopt an interesting and efficient way of teaching children. Thus, introducing 

children’s learning books for educational benefits can be a good option for 

you, especially if you are looking forward to make money in this industry. 

Create audio books that can be used in children’s curriculum or just to keep 

them entertained.  

Now that we’ve covered all the important aspects of planning for audio books, 

it is time we learn how to actually create one. The next section includes a step-

by-step guide on how to record an audio book on a very well-known and 

reliable platform – Audacity.  
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Recording Audio Book on Audacity – Step 

by Step Guide to Technicalities 

One option to record yourself reading your book is to use the free online 

recording software known as Audacity.  However, if you have a MAC you may 

choose to use “Garageband” to record your book.  There are many free 

tutorials on YouTube to guide you on how to use Garageband if you don’t 

know how.  Garageband is for MAC’s only and you can view more about 

Garageband on their official website. 

You can also use “Adobe Audition”, which you can buy outright or rent month 

to month for $19.99 on their official website. 

Step 1   

We will be using Audacity, free-to-use audio-editing online software required 

to record your audio books. Thus, downloading and installing Audacity is the 

first step in getting started. Visit Audacity’s official website, and download 

Audacity 2.0.3 Select the ‘Save’ option and choose file location when the 

dialogue box for security warning appears. The installation wizard can be 

launched by double clicking on the downloaded file. Save Audacity to your 

computer.  

 

http://www.apple.com/au/ilife/garageband/?cid=wwa-au-kwg-features-0001&siclientid=6642&sessguid=1cf22749-9d67-4995-9814-c9f0930781f1&userguid=1cf22749-9d67-4995-9814-c9f0930781f1&permguid=1cf22749-9d67-4995-9814-c9f0930781f1
http://www.adobe.com/au/products/audition.html
http://audacity.sourceforge.net/
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Step 2 

Once Audacity is downloaded and installed on your computer, you can launch 

the program and start recording your book. The next step is to adjust the 

essential equipment, including the microphone. Most computers have a built-

in microphone socket. Make sure you are recording in a very quiet room with 

the minimum of background noise and interruptions possible.  

 

Step 3 

Set your recording settings as follows within Audacity: 

- Uncompressed AIFF (44.1 KHz, 16- bit, 2-channel stereo files required) 

- MP3 (320KBps, constant bitrate recommended; 44.1 KHz, 16- bit, 2-

channel stereo files required) 

 You can also see “Createspace’s” Guidelines on recording if you are unsure 

over here. 

Step 4 

Take a Take a few minutes to learn about the different playback and recording 

control options of Audacity. The options available at the top include record, 

https://www.createspace.com/Products/MP3/Index.jsp
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skip forwards, skip backwards, stop, play and pause. When you are all set with 

your microphone, click on the Record button in red to start recording. You will 

see Audacity creating sound waves visualization on the screen as soon as you 

input voice. If you require a break, or are interrupted, click on the Pause 

button. Hit the Pause option again to resume recording.  

 

Step 5 

When the section or chapter ends, click on the Stop button. You can listen to 

the recording to check by clicking the Play button. If you wish to edit any part, 

make sure you save the project before you begin editing. You can do so by 

accessing the File Menu and clicking on Save Project. If you are satisfied with 

your recording the first time and wish to make no further changes, skip directly 

to Step 9. In case you wish to edit areas where you coughed or misspoke 

sentences, the editing task is easy. Simply click and drag, using your mouse 

pointer, the section you wish to remove and click Cut.  
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Step 6 

There are other ways of editing too. You can mute a small section of the 

recording without the need to delete it completely. For instance, to remove 

excessive background noise, especially where a dramatic intentional pause is 

included. Use the Silent tool for this. This button is available on the toolbar. 

Similarly, if you wish to move to create duplicates for any part of the recording, 

click and drag the section to highlight and choose the Copy option from the 

Edit menu. In the Edit menu, select Paste when you are on the desired 

destination location. To move the section to another destination location and 

delete it from the original one, choose Cut instead of Copy.  

 

Step 7 

Feel free to add desired sound effects or music in your audio book. If you wish 

to add background music of your choice, use the Import option in the File 

menu to add the track. You can even record a track using the Audacity program 

in another window. This new audio file can also be separately edited using this 

software. Add the track on the desired destination location. Moreover, if you 

wish to give special effects to the recording, such as a reversed section or echo, 

click and drag the section to highlight and select the desired effect available in 



23 | P a g e  

How to Create an Audio Book 
© 2013 

the Effect menu. Click undo and choose again if you are not satisfied with your 

first choice.  

 

Step 8  

Editing also includes removal of unwanted hiss or noise in the background. 

There is a proper Noise-Removal option in Audacity to do so. This option is 

different from the Silent tool. Click and drag to highlight the noisy background 

recording portion. Click on the Effect menu and select Noise Removal. Select 

the button Get Noise Profile. Next, select the whole recording and reopen the 

tool option, and choose Remove Radio from the options and press OK.  
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You can also run your audio through a free “online” enhancing program called 

Auphonic.com.  If you upload your completed audio file to Auphonic, the 

program will clean up your audio file by removing unwanted background hums 

and noise, for free.  Then you simply download it again ready to publish. 

Step 9 

At the end of each section or chapter, save them in different files and order. 

However, before you are ready with your complete audio book, you must join 

the two separate files together. To do so, open both Audacity windows 

separately. Select the entire recording on the second menu and choose Copy 

option in the Edit menu. In the first window, place the mouse cursor at the end 

of the recording and select Paste from the Edit menu. Make sure you remove 

the joint between the two files with the Clip Boundaries options, available in 

the Edit menu. The Join function appearing in the submenu will be used to 

make it a single, continuous file. Save and repeat the same steps to add further 

chapters to your original file.  

 

Step 10 

Your audio recording is now complete and must be exported so that it can be 

used in other programs in addition to Audacity. Click Export in the File menu to 

https://auphonic.com/
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export your saved audio file. Save the file with .wav extension you can find in 

the dropdown menu and ‘Save’ the file with an appropriate name. At saving, 

you will be required to input additional details about the file, also known as 

metadata. 

Because Audacity does not convert files into MP3 format by default, you 

simply download the “Lame” software and the website hosting “Audacity” 

explain why you can’t save your Audacity recordings as an MP3 here.   The 

download page for LAME is here – again this is free (although you can make a 

donation).  Once you have saved the software to your PC or MAC and run the 

program, you can simply save your recording as an MP3 format instead of .wav 

in the dropdown menu when you go to export (save) your recording direct 

from Audacity.  The two programs work together seamlessly.  

Step 11 

To use the Windows Media Player to burn your entire audio book to a CD you 

simply launch Audacity and choose the Burn tab. Select and drag the desired 

audio file and leave it in the blank list space. Meanwhile, insert an empty 

compact disk in the CD drive and hit the Start Burn button.  

Publishing and Distribution – Successful 

Platforms to Launch your Audio Book 

When your audio book is done, you need to get it out to the right markets 

efficiently. The industry for audio books is particularly reliant on online 

libraries and is also influenced by physical sales. Considering this fact, many 

http://manual.audacityteam.org/o/man/faq_installation_and_plug_ins.html#lame
http://lame1.buanzo.com.ar/#lamewindl
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audio book publishers prefer promoting digital editions of their book along 

with physical media such as MP3 CDs.  

As far as digital media distribution is concerned, you may find it a little 

challenging.  It is possible to publish with iTunes and Amazon (Audible) direct, 

but if you live in the US, you can simply publish your audio book with the 

distribution company ACX.com and they will distribute your audio book to all 

the relevant audio book online sellers.  ACX currently only accept audio book 

submissions from only US residents with the appropriate tax certification.   

ACX also have a special program running at the moment whereby if someone 

purchases your audio book as one of their first three purchases on Audible, 

then you will be paid a $25 bonus (or shared with the narrator if you are on a 

50/50 commission split arrangement in place).  You can qualify for this $25 

bonus over and over again, so encourage your friends to join and hire your 

audio book in their first three audio book purchases!   

You can also submit your audio book directly to Audible.com, even if you don’t 

live in the US.  See below for a copy of their conditions taken from their 

website as at March 2013: 

  Domestic Content Partners: If you are (or your company is) an audiobook publisher located in 

the United States, and you would like to sell audiobooks through Audible’s channels, please click 

here to learn how you can become an Audible partner. Please keep in mind that since Audible 

customers pay for the content they buy here, we prefer not to carry content (whether audiobooks 

or podcasts) that is offered free elsewhere on the Web. Learn more about this policy here.  

International Content Partners: If you are (or your company is) an audiobook publisher located 

OUTSIDE of the United States, and you would like to sell audiobooks through Audible’s channels, 

please send an email to internationalpartner@audible.com. In your email, please describe the 

genre and length of your audiobooks, and let us know how much content you currently have and 

how much you’ll publish over the next six months. Please keep in mind that since Audible 

customers pay for the content they download here, we prefer not to carry content (whether 

audiobooks or podcasts) that is offered free elsewhere on the Web. Learn more about this policy 

here. 

http://www.audible.com/
http://www.acx.com/
http://www.audible.com/
https://www.acx.com/help/audiobook-publishers/200679720
https://www.acx.com/help/audiobook-publishers/200679720
http://about.audible.com/contact-us/what-content-is-the-most-popular-with-audibles-members
mailto:internationalpartner@audible.com
http://about.audible.com/contact-us/what-content-is-the-most-popular-with-audibles-members/
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Also, on Audible’s website they have a page titled “What content is popular” 

for the Audible audience, and below is a copy of that page: 

  Unabridged audiobooks – Audible members mostly prefer unabridged 

audiobooks. These audiobooks are expected to be professionally narrated in 

high-quality studios, and professionally edited and mastered. 

  Long-form programs – The majority of Audible’s customers prefer longer-form 

content (5+ hours). If you have short-form content, please consider thematically 

bundling it into one longer product to ensure you have the best chance of 

exposure to our members. 

  Podcasts and other “free” programs – We’ve had countless conversations with 

our customers on this topic. They have told us that they get frustrated when they 

find out that the content they buy at audible.com is available at no charge in 

other places on the Web. Many of our customers have even reviewed these books 

negatively for this reason; as you know, such reviews can show up in public 

search sites such as Google, Yahoo and others, and can be damaging to the 

author’s brand as well as to the publisher’s brand. Therefore, we think it is best 

for our customers and authors that we not sell content that is offered at no 

charge in other places. 

  A few words of advice — Audible’s members love audiobooks! However, not 

every print book will create a great listening experience, and other genres are 

just not popular with our members. Based on our experience, the following types 

of books are not good candidates for audio:  

 o Abridged audiobooks 

 o Audio products that include advertising messages 

 o Books in the Public Domain 

 o Reference books, guide books, quotation books, and dictionaries 

 o Books about home and garden, interior design, home organization, or 

storage 

 o Gift books and other short illustrated books 

 o Cookbooks and diet books 

 o Comic books and graphic novels 

 o Photography books or art monographs 

 o Engineering or other professional reference books 

 o Flashcards, calendars, and box sets 

 o Sports books (especially ones that rely heavily on pictures) 

 o Travel guides (especially ones that read as reference guides) 

 o Any book that relies heavily on visual elements throughout the text (e.g. 

many business, science, astrology and fitness books) 

If you live in the US and want to publish on Amazon the procedure to publish 

your audio book with them will be: 

1. Open an ACX.com account 

2. Choose territories and terms of distribution 
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3. Read and accept their terms 

4. Upload your audio book 

If you live outside the US you are required to write to them by email at 

internationalpartner@audible.com and ask permission to upload your audio book.  

They require basic information like what you are publishing, if you have other 

books to come, and if it is original work. 

Essentially, Audible is concerned with your audio book being: 

1. Your unique content (not something on the public domain or PLR) 

2. Owned by you to legally publish 

3. A good quality recording 

You can consider other companies such as Open Book Audio, and get your 

audio book into iTunes, Audible, Listening Library and other publishing outlets.  

Another option available for you is the ‘AudioBooKarama’. You can actively 

become their partner (according to the terms and conditions set by them) and 

use their audio book self-publishing program service to publish your audio 

book.  

Submit to iTunes direct 

If you wish to launch your audio book on Apple devices yourself, it is a must to 

inform them it’s an audio book and not a music file. Launch iTunes and add the 

audio files to the Library by simply clicking and dragging them. Choose the file 

and right-click and select Get Info option. Check out the Options menu and in 

the Media Kind menu, choose Audio book. Once the file is synchronized, it will 

appear in iTunes under the section of books as well as on your smart device.  

mailto:internationalpartner@audible.com
http://www.openbookaudio.com/content/sell-your-audiobook
http://www.audiobookarama.com/
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In summary, if you live in the US, just use ACX.com to publish your audio book, 

and if you live outside the US, write to Audible.com direct and request 

permission to publish with them direct. 

Physical Audio CD Products 

You may consider other options for physical CD distribution of your audio book 

including Createspace and Kunaki, however, Createspace does not “officially” 

publish and distribute “audio books”.   

Submit direct to Createspace 

If you upload an MP3 to Createspace, it will list it as a DVD with Amazon (under 

movies) and on iTunes it will be listed under music. 

At best, the royalties are set out below as at March 2013: 

https://www.createspace.com/Products/CD/
http://kunaki.com/home.asp
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You will also need to have the correct artwork requirements met, they are: 

- 1448 x 1448 px 

- It is to be a flat image, not like a CD 3D box 

- With no logos 

- JPG 

See the screenshot below of their actual submission guidelines as they may 

change from time to time.  Go here to keep up to date and see below for their 

recommendations as at March 2013. 

https://www.createspace.com/Products/MP3/Index.jsp
https://www.createspace.com/Products/MP3/Index.jsp
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If you decide to list your CD for distribution with Createspace, you need to be 

aware it may be rejected.  However, here are the instructions to list with 

Createspace if you decide to go that way anyway: 

Step 1 

Open an account with Createspace here. 

https://www.createspace.com/Signup.jsp
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 Step 2 

Once you have opened an account, go to the top navigational bar, “Books, 

Music, Film” etc and select the drop down menu of “Music”.  Select the 

“Amazon MP3” option. 
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Step 3 

Then you should click on the “Create a MP3 download”.  This will open up a 

registration form. 

 

Step 4 

In this registration form, you need to type in the “Title” of your audio book, try 

to avoid using the words “audiobook” in the title.  Then choose the “MP3” 

option, and you should select the “Guided:   A step-by-step process with help 

along the way.  Get Started” button.  This will open up a new window. 
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Step 5 

In this new window, your title you entered in the last window will appear, 

which you can still edit if you need to.  Then under it you should type in your 

name as the “Primary Artist” (this is what is published, so only type the name 

you are happy to put on the book), and you can type in more than one name. 

Ignore “Record Label” and put the length of the whole audio book under 

“Duration”.  You can ignore “SKU”, this is a code for only you.  Then click on 

“Save & Continue”. 

This will take you to another window now.  

 

Step 6 

We are still in the “Set up” boxes (as the left side menu shows) and you are 

now in the “Audio Track” listing area.  Simply click on “Upload” if you want to 
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attach your audio file and send it with this digital application, or click on “Send 

us your Audio CD”.   

You are now working through those four modules of the “Setup” menu, and 

you can jump back and forth with ease by simply clicking on the relevant 

module of your choice.  Make sure you save before you click away or you will 

lose any information you entered after you saved last. 

Createspace will also keep your details stored if you save, and then return 

another day to finish. 

 



36 | P a g e  

How to Create an Audio Book 
© 2013 

 

You are required to now enter in each “Chapter” (which would be like your 

table of contents of your chapters) under the “Track Name” and “Track Artist” 

should always be your name (as you are happy for it to be on the final book). 

When you “Upload” your audio chapters, they have to be added to one folder, 

as an MP3 file per chapter.  Then the file must be “zipped” to compress it for 

faster uploading.  A free online “zipping” program is WinZip found here. 

If you want to send your physical audio CD in the mail, you should also check 

their page on their requirements for audio CD’s to be accepted by them over 

here and see below. 

http://www.winzip.com/win/en/index.htm
https://www.createspace.com/Products/MP3/Index.jsp#content3
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Step 7 

The last thing in set up to do is to select “Use a CreateSpace-Assigned UPC” 

then save. 

 

Then you will be in the “Complete Setup” window, which will show a summary 

of everything you have eneted. 

Then you go to the “Review” page and check everything again, then in 

“Distribute” you select “Amazon” and complete any other miscellaneous 

information they require. 

Then you submit your audio book for review by Createspace, who check the 

quality of the work, the cover art is correct size etc and they normally advise 

you within a week of your project being accepted or rejected.  It can also take 

up to three weeks, but their support department is known to be quite good, so 

just email them if it is taking a long time. 

 



39 | P a g e  

How to Create an Audio Book 
© 2013 

Other Publishing Options 

CDBaby.com create your physical CD product as well as attempt to list your 

digital audio book on iTunes and Amazon, however, CDBaby also advise that 

iTunes and Amazon have an exclusive agreement with Audible for their 

audiobook content and they can only attempt to publish your audio book with 

iTunes and Amazon, but they can’t guarantee it.  Your audio book will be in the 

music section, most likely under the genre of Spoken Word.  

The entire spoken word release will be for sale based on a 99¢ per track 

download price.  Any track/chapter of your release will be available individually 

for 99¢ unless that track is over 10 minutes in length.  Tracks over 10 minutes 

will sell at the "Album Only" price.  

However, if your album clearly appears to be an audiobook ("audiobook" is in 

the title, the cover looks like an audiobook, etc), and is not a spoken word 

album, it may not be able to be delivered to iTunes or Amazon as it would 

violate their arrangement with Audible. 

Podio Books 

Podiobooks are gaining popularity because all the books on Podiobooks are 

free.  You can upload a sample of your book for free, with a link to your 

Amazon book to purchase.  Publishers and authors who have been using this 

platform know that this new place for audio books can help them develop and 

expand their fan following. It absolutely makes sense to provide a dedicated 

book page to Podiobook. 

http://www.cdbaby.com/
http://www.audible.com/
http://podiobooks.com/
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You can learn more about Podiobooks and how you can share your audio 

books using their service from their website here. Meanwhile, don’t forget to 

check their Author’s Page and their titles available currently.   

Promotional Strategies for Audio Books 

For audio books available for sale, you must promote them on the web to 

enhance sales. You can upload your audio book to SoundCloud.com which will 

then provide you with a free “player” of your audio which you can embed the 

player onto your website or your blog.   

To establish an active online presence and market your audio book you should 

consider all of the following options: 

Website – This online platform is a major source of audio book marketing, 

typically used by many audio publishers today. Make the most out of your 

website. Before you launch the book, create a marketing campaign to promote 

your book on your website. A little planning and a small place on your website 

is all that your audio book needs for recognition. 

Blog – You won’t find a better way to keep your listeners connected and 

informed other than your blog. This is another online platform where you can 

share with your audience the tit bits and sneak peeks of your audio book 

recording you are about to release. A blog is a great platform to create hype 

even before the book is published.  

Social Network – A place where you meet your customers all around the 

world… and you know the rest!  

  

http://blog.podiobooks.com/how-to-get-your-books-listed-on-podiobooks-com/
http://blog.podiobooks.com/how-to-get-your-books-listed-on-podiobooks-com/
https://soundcloud.com/
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Conclusion 

Audio books are continually gaining popularity and are expected to rise at the 

same pace in the future as well. Thus, this indicates the best time to be 

working on such projects. Even if you are not looking forward to making money 

from it, audio books can give you recognition as an author that you might have 

been missing earlier.  

Introducing your own audio book is simple; however you need to have a 

proper plan in your mind. Other than the type of book, subject, category and 

content, there are factors such as its promotion, distribution and launch that 

play a great role in how your audio book turns out.  

You can’t be a pro in your first attempt. So give it a try until you find yourself 

ready to launch your own audio book. Research your options and assess them 

according to your individual requirements before you get started.  

This book answers all the questions and concerns in your mind regarding audio 

books. With the knowledge shared here, you will be able to put your best foot 

forward for your first attempt. Hope the useful information you read here 

helps you achieve success in the audio book publishing journey.   

Good Luck! 

 

 

 

 

 


